Exercise 5. Building ArcGIS Tools using Python
GIS in Water Resources, Fall 2014

Prepared by Anthony Castronova

Purpose

The purpose of this exercise is to illustrate how to build ArcGIS tools using the Python
programming language. Python is included with ArcGIS. This exercise will guide you
through the processes of collecting data via ArcGIS services, creating and running an
ArcGIS Python script and creating a model builder tool interface for the script. The
purpose of the ArcGIS tool is to provide you with an example of how to manipulate
shapefiles, iterate over raster datasets, execute native ArcGlIS tools, as well as define
ArcGIS tool parameters. Overall, it will provide guidance on how to build your own
ArcGIS tool. The tool outlined in this exercise will trace a user-defined point
downstream until it hits a watershed outlet.

Learning Objectives
e To be able to create and run a python script using ArcGIS functions in the arcpy
library
e To be able to configure a user interface for an ArcGIS python script
e To be able to split a problem into individual steps and program these steps into a
Python script that executes them in sequence to solve the problem

Computer and Data Requirements

To carry out this exercise, you need to have a computer that runs ArcGIS 10.2 or higher
and includes the Spatial Analyst extension. No data is required to start this exercise. All
the necessary data will be extracted from ArcGIS.com services. To use these services you
need an ArcGIS.com account that has been linked to an ArcGIS license.

This exercise is divided into the following activities:
1. Data Collection
2. Developing a python script
3. Developing a toolbox interface for a python script



Part 1: Data Collection

This section of the exercise uses ArcGIS.com tools to delineate a watershed and extract
the DEM as you have done in previous exercises. This gets us the data for using in the
model building and python scripting part that follows

Open ArcMap.

Connect to the ArcGIS hydrology server http://hydro.arcgis.com/arcgis. We will use this

to delineate a watershed.
Add ArcGIS Server == General ==

This wizard guides you through the process of . i i
making a cngnechn!:\ toan ArchIS S'E:Ir\der‘ You can Server URL: Ritp: fhydro. arcis.comfarcgis

create a connection to use, publish, or administer
GIS services. ArCGIS Server: http:/fgisserver . domain, com: 6080/ arcgis

Authentication (Optional)

Eh laj What would you like to do?

(@) Use GIS services

User Name: dearb

() Publish GIS services Password: Y|
() Administer GIS server
- Save Username/Passward

About ArcGlIS Server connections

< Back ][ Finish ][ Cancel

If added correctly, you should see the following tools listed in ArcCatalog.

ISW&E] arcgis on hydro.arcgis.com_443 (user)

= £ Tools
= E Hydrology

&
%, TraceDownstream

"{Q Watershed

Next, add a connection to the ArcGIS landscapel server. We will use this web service to
download and visualize National Hydrography Dataset (version 2) rivers. Use
https://landscapel.arcgis.com/arcgis/services as the URL. If added correctly, you will
see long list of datasets under the landscapel service in ArcCatalog.



https://landscape1.arcgis.com/arcgis/services

EFeE|arcgis on landscapel. arcgis.com 443 (user)]
£ Tools
3 utilities
@ USA_Active_Quaternary_Faults
(2l UsA_All_Fed_Lands
@ USA_Aquifers

ArcGIS Server User Connection Properties

General

(23] [E] usA_BLM Lands
(B UsA_Coal Bed_Methane _Basin
(& usa_Coal Fields

Server URL:

ArcGIS Server: http: //gisserver.domain.com:6080/arcgis

Authentication (Optional)
User Mame: tcastronova
Password: LAL LAl L]
Save Username Password

About ArcGIS Server connections

(B Usa_Critical_Habitat
@ USA_Earthquake_Risk
[E usa_Flood_Risk

@ UsA_Geology_Units
@ USA_Hazardous_Waste_Sites
(2] Usa_Histeric_Sites
(8 usa_NCED

B usa_NHDPIusV2

(& usa_NPDES

(@ usa_NPS_Lands

@ usa_Ntv_Lands

[E usa_0il_Shale_Basins
@ USA_Railroads

(@ usa_Roads

(2l ysa_Soils

(2l UsA_USFs_Lands

(Bl ysA_USFWS_Lands
HApply @ USA_Wetlands

@ USA_Wilderness_Areas

Finally, connect to the ArcGIS elevation web service. This will be used to downloading

elevation data for the exercise. Use http://eleva

tion.arcgis.com/arcgis/services as the

URL. If added correctly, you will see a short list of tools and data available under the

elevation service in ArcCatalog.

ArcGIS Server User Connection Properties @
General
server URL: tps: /felevation. arcgis.com: 443/arcgis fservices,

ArcGIS Server: http: [fgisserver .domain.com: 5080 /arcgis

Authentication (Optional)
User Name: teastronova
Password: sssssass
Save Username/Password

About ArcGIS Server connections

= LU arcgis on elevation.arcgis.com (user)

= EJ Teels
E Elevation
E ElevationSync
= 5 WorldElevation
@ DataExtents
@ Terrain
@ TopoBathy
i NED30M

Add some template data so that we can zoom into the location that we would like to

download data. Select the Add Data button:

O d o g



http://elevation.arcgis.com/arcgis/services

Navigate to the ArcGIS template data directory (C:\Program Files

(x86)\ArcGIS\Desktop10.2\TemplateData\TemplateData.gdb\USA) and add US cities,

interstates, and states.

*rllandbnds

Bl neighcountry
S taes]
El|us_lakes
“|us_rivers
*rlusabln

MName: dties; intrstat; states

’Add Data @
Loak in: ['ﬁms.ﬁ. V]%@L&|%'|E|E‘L—-’&
El| counties
= intrstat

Show of type! | patasets, Layers and Results

)

[ Cancel ]

-

The map should now look like this:




Zoom into Logan, UT. Use the Identify tool to determine which of these dots is Logan.

This will give us an idea of where we are, before we start loading ArcGIS web service

datasets.

Identify

Identify from:

[=-U.5. Cities
--Logan

Location:

-109,527213 40.319706 Decmal Degrees

| <Top-most layer> ﬂ

Field
OBJECTID
Shape
CITY_FIPS
CITY_NAME
STATE_FIPS
STATE_MAME
STATE_CITY
TYPE
CAPITAL
ELEVATION
POP1990

Value

712
Point
45850
Logan
49
Utah
4345360
dity
N
4535
32762

Add the NHDPIus (version 2) data set from the landscapel.arcgis.com web service.

[}

HEHE EHEEHE

LUsa MCED
Usa_MPDES

UsA MPS Lands
USA Mty _Lands
U5A_0il_Shale_Basins

We are only interested in the stream data, so turn off all NHD layers except Streams.

This will help speed up the data load time. The layers in your table of contents should

look like this:




= £ My Data
= Uss_MNHDPlusY2
[ Sinks
] MHD Waterbodies
] MHD Areas
MHD Streams Mean Annual Flow
=] .5, Cities
&
=] L5, Mational Transportation Atlas Interstate

= L5, States (Generalized)
]

Now that we have the NHD rivers loaded, we can zoom into Right Hand Fork.

Identify ) e
Identify from: I <Top-most layer> \ v - B
[ (=) NHD Streams Mean Annual Flow I —
i Right Fork Logan River G i
- B '_\ E
Em| T
Location: -111.633275 41.780751 Decimal Degrees ] 'I_J -
| e _
—— | Field Value |~ -
OBIECTID Mull =
ComID 654348 | 4
GMIS Name Right Fork Logan River
Length (km) 1.953
Reach Code 16010203000538
L Flow Direction With Digitized




To delineate a watershed at Right Hand Fork, we will use the ArcGIS online watershed
delineation tool. Double click on the ArcGIS server watershed tool.

= 7 arcgis on hydro.arcgis.com_443 (user)
= £ Teels
= E Hydrelogy
% TraceDownstream

Y Watershed

Select an input point near the outlet of Right Hand Fork (see green dot on map). Don’t
get too close to the Logan river (downstream), or the delineation tool will snap the
outlet to the wrong reach. To ensure that this does not happen, you may have to adjust
the snap distance (try 100 meters)

s - _ S 5

#, Watershed = || =& A ¢
- : ..-\
Input Points
Watershed:InputPoints ﬂ
& InputPoints

Point Identification Field {optional)

Snap Distance (optional)

Snap Distance Units (optional)
Meters -

Data Source Resolution {optional) ' - i

|| Generalize Watershed Polygons {optional)

Retum Snapped Points (optional)

P e —

[ OK ] [ Cancel ] ’Environments... ] ’ Show Help == ] - _[/_,f

This operation will result in the Right Hand Fork watershed. Go ahead and turn off all
unnecessary layers and change the watershed color to something more meaningful.
Export the in-memory watershed data to create a new shapefile, called watershed.shp.



We will use this new watershed.shp file in the following step to extract elevation data
over the watershed.

Right Hand Fork

Add NED30m elevation from the elevation.arcgis.com server.

= 7 arcgis on elevation.arcgis.com (user)
= £ Tools
E Elevation
E ElevationSync
= EJ WorldElevation
@ Databxtents

@ Terrain

i TopoBathy



RightHand Fork

Next we want to extract the elevation data within the boundary of our watershed. This
will make future data processing faster since we will be using a small subset of the
national elevation dataset. In addition, this file will be stored locally so we won’t need
an Internet connection to perform our processing tasks. To do this, open the search
menu and enter “Extract”. Make sure to choose the search by “Tools” option above the
search textbox. This will limit the search results ArcGIS tools. Since we are dealing with
elevation data from an ArcGIS server, we want to select the “Extract Data (server)” tool.

Search

B
M L R (= T

ALL  Maps Datz  Tools Images

IExlract | @) [ |

a el
- <ONED3IM
1
+

3’ Extract Data

Layers to Clip

Any Extent v

Search returned 33 items v Sort By v

&) Server (Toolbox)
The Server toolbox contains tools to manage ArcGI...
toolboxes\system toolboxes'\server tools.tbx

& Data Interoperability (Toslbox)
The Data Interoperability toolbox contains a set of t...
toolboxes\system toolboxes\data interoperability to...

Area of Interest
& Extract (Toolset)

Summary: net available.
toolboxes\system toolboxes\analysis tools.thx\extr... | watershed = &
[l Area_of Interest|

& Extract (Toolset)

Summary: not available.

toolboxes\system toolboxes\coverage tools.tbx\ana...
Feature Format

& Extraction (Toolset) File Geodatabase - GDE - .gdb

Summary: not available.
toolboxes\system toolbexes\spatial analyst tools.tb...

& Data Extraction (Toolset)
Summary: net available.
toolboxes\system toolboxes\server tools.thx\data e...

& Extract Data (Server) (Tool)
Extracts selected |ayers in the specified area of int...
toolboxes\system toolboxes\server tools.thx\data e...

e Extract Data Task (Server) (Tool)
Extracts the selected layers in the specified area o...
toolboxes\system toolboxes\server tocls.tbx\data e...

}u Extract Data and Email Task (Server) (Tool)
Extracts the data in the specified layers and area ...
toolboxes\system toolboxes\server tools.tbx\data e...

Raster Format
ESRI GRID - GRID

Spatial Reference
Same As Input

Custom Spatil Reference Folder (optional)

Output Zip Fie
2Z:\windows_shared\exerdise 10_28_14\example_data\elevation.zip

&
=

ok |[ cancel | [Environments

| [ show belp =




Select the NED 30m elevation raster as the layer to clip. The Area of Interest that will be
used to extract the data (i.e. cookie cutter) should be the watershed that you delineated
in previous steps. Leave the default options for Feature Format, Raster Format, Spatial
Reference, and Custom Spatial Reference Folder. Specify an output ZIP file where the

extracted data will be saved.

Open Windows Explorer and navigate to the directory of your output ZIP. Extract the
contents, and you should now have an elevation dataset that covers only the watershed

area.

This is a good time to change the projection of our data frame to match the
coordinate system of this elevation data. Also be sure to change the map units to be
consistent with the units of the coordinate system.

Data Frame Properties

=]

| Feature Cache | Annotaton Groups | Extert Indicators | Freme | Size and Postion |

General Data Frame Coordinate System

% v | Tueehere tosearch

MICE IR R ¢

llumination Grids:

55 Favorites
5 Geographic Coordinate Systems
[ Projected Coordinate Systems
E5 Layers
= Custom

€3 NAD_1983_Albers

Current coordinate system:

NAD_1983_albers
Authority: Custom

Projection: Albers
False_Easting: 0.0

False Northing; 0.0
Central Meridian: -96.0
Standard_Parallel_: 20.0
standard_Parallel_2: 60.0
Latitude_Of_Origin: 40.0
Linear Lnit: Meter (1.0)

Cancel Apply

Data Frame Properties [=]
Feature Cache | Annotation Groups | Extent Indicators | Frame | Size and Postion |
Gereral | Dataframe | Coominate System | llumination | Grds |
Name: Layers
Desaiption:

Credits:

Units
Map: Meters

Display: | Meters

Tip:  See Customize > ArcMap Options > Data View tab for

bar

Simulate layer transparency in legends

additional options for displaying coordinates in the status

Reference Scale: <Neone>
Rotation: 0
Label Engine: Standard Label Engine

s

Apply
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Part 2: Developing a python script

The goal of our scripting tool is to trace any point within the watershed downstream to
the watershed outlet. This can later be modified to provide statistics regarding the flow
path. This example will demonstrate (1) how ArcGIS tools can be used to create a
custom model, (2) how to include custom data processing and functionality, and (3) how
to build the ArcGIS tool interface for a custom tool.

An effective way to learn programming is by example. ArcGIS models built using model
builder can be exported as python scripts that serve as examples that show how ArcGIS
functions are used in python. The exported file also serves as a template for you to edit
to develop the tool you want to use. The strategy will be to

(1) create a model using model builder

(2) export it as a python script

(3) set the inputs and outputs and run the script

(4) make incremental changes to the script running after each change to ensure that

the script still works

Note that developing Python scripts for ArcGIS is hard and sometimes you encounter
errors that appear insurmountable. If this should happen to you do not waste too much
time on this. A complete set of scripts from this exercise have been posted in
http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2014/Ex5Scripts.zip. These are
named tracel.py, trace2.py ... up to trace5.py then the final script is trace.py. The
exercise below has check points and indicates which script applies for work up to that

point. If you get stuck feel free to go to the next check point and start with the
corresponding script and move on. The questions at the end can be done with small
changes to the final script trace.py.

Activate the ArcToolbox by clicking . Create a new toolbox by right clicking inside
the window and selecting Add Toolbox from the context menu. This will open a dialog
for you to search for an existing toolbox. Instead, navigate to any directory that you like

S

and select the create New Toolbox button in the top right corner
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http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2014/Ex5Scripts.zip

Add Toolbox
Lookin: |5 Home - Exerdse 10_28_t\prar ~| & fr @ | EE v | 4| EU B @

[ elevation

3

Name: Toolbox. thx

Show of type: | Toglboxes v] [ Cancel ]

After creating your toolbox (i.e. Exercise 5), right click on it and select New -> Model.

B ArcToolbox
ﬂ 3D Analyst Tools
& Analysis Tools
a Cartography Tools
a Conversion Tools
£ Data Interoperability Tools
& Data Management Tools
3 Editing Tools
P {Ees
£ Geocoding Tools
B3 Geostatistical Analyst Tools
a Linear Referencing Tools
a Multidimension Tools
B3 Network Analyst Tools
ﬂ Parcel Fabric Tools
a Schematics Tools
a Server Tools
& Spatial Analyst Tools
ﬂ Spatial Statistics Tools
a Tracking Analyst Tools

You will end up with an empty model. Drag and drop the Fill tool onto the canvas, along

with the clipped elevation raster.

P
43 Model
Madel  Edit

B& +BEX 2>

Insert  View Windows

Help

o

HHERIL YR

58 N oAk ew

m

I

From the menu, select Model -> Export -> To Python Script and save the script with the

name trace.py. (Named trace.py because that is the ultimate goal of our work)
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Model | Edit  Insert ‘iew ‘indows Help

b Run IR Y
1 Run Entire Model
' alidate Entire Model
&= Sawve

Save A,

Delete Interrmediate Data

Print Setup...

Fill_ne
1

Print Presiewy..,

Print...

i[e

Repart..,
%" Model Properties..

Diagrarn Properties...

| Export »

To Graphic..,
Tao Python Script...

Irmport »

Closze

Close the ArcMap model. From the Windows Explorer open the exported Python file to
view the code that was written for us by ArcGIS. We can do this using the IDLE
application by simple right clicking on the file and selecting “Edit with IDLE.”

117 014 9,45 AR

~ trace.py
G e

|| waters|

|| waters Edit with IDLE

You should see the following Python Idle editing window.
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trace.py - C:\Users\dtarb\Desktop\ExS\trace E‘ﬂu
File Edit Format Run QOptions Windows Help l

h —-*- coding: utf-8 -*- -
o

# trace.pv

# Created on: 2014-11-01 08:45:34.00000

7

7

7

(generated by ArcGIS/ModelBuilder)
Description:

# Import arcpy module
import arcpy

# Check out any necessary licenses
arcpy.CheckCutExtension ("spatial™)

# Local wvariables:
ned30m = "C:\\Users'\‘\dtarb\\Desktop \\Ex5\\n=ed30m"
Fill ned3om2 = "C:\\Users\\dtarb\\Documents‘\\RrcGIS\\Default.gdb\\Fill ned30m2"

# Process: Fill
arcpy.gp.Fill sa(ned30m, Fill ned30mZ, "")

lLn:1/Col:0

Although cryptic to a reader new to Python this is readable. Comment lines are
preceded by # and are not run. You can see the line to import the arcpy library that tells
the script to use ArcGIS functions. Then there is the line to use the spatial analyst
extension, two lines to specify the input variables. These are files on your disk. Then
there is the command to run the Fill function.

Lets run this script. Select Run -> Run Module

,

File Edit Format IRun Options  Windows  Help
I# -*— goding: [F--"~-"~"~"~"~~--—---

Foommmm Pythen Shell ~ F———————————————-
# model.pv
# Created on: Check Module Alt+X onon
F [generate er)

Il # Description:
o

The Python Shell should open and your script will run. There is no output from this
script to the shell so your only indication that it is done is the appearance of the third
>>> prompt.
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%% Python 2.7.5 Shell

I Eile Edit Shell Debug Options Windows Help

Bython 2.7.5 (default, May 15 2013, 22:43:36) [M5C +.1500 32 bit (Intel)] on v
32

Type "copvright™, "credits" or "license ()" for more information.

i RESTART
e

Note the following lines in the script.

# Local wvariables:
ned30m = "C:\\Users\\dtarb\\Desktop \\Ex5\\ned30m"
m2 "™

Fill ned30m2 = "C:\\Users\‘dtarb\\Documents'\ArcGIS\"Default.gdb \\Fill ned3d

# Process: Fill
arcp¥.gp.-Fill =sa(ned30Om, Fill ned3imZ, "")

These define ned30m and Fill_ned30m?2 as variables with values to the right. Then the
line below executes the Fill function with these as input and output. If your script ran
correctly you can look in the destination location
"C:\users\dtarb\Documents\ArcGIS\Default.gdb" above and see the result.

You may get an error due to input files not being correct. If you get the error do not
worry about it as our next step will be to change the location of inputs and outputs.

Note that in Python \ is an "escape" character so to get folder paths that include it you
need double \\. Alternatively you can use "/".

Now lets modify this code so that the variable names and files used make a bit more
sense

Change the file to the following and rerun it

15



File Edit FormatERun Options  Windows Help

Description?

F - coding:! |_ _ _ _ _ _ _ _ _ _ _ _ _ ~
e s

+ trace.py Python Shel

# Created on: Check Module  Alt+X oooo

$ (generate er)

i

F

# Import arcpy module
import arcpy

# Check out any necessary licenses
arcpy.CheckCutExtension ("spatial™)

ocal wvariables:
levation = "C:/Users/dtarb/Desktop/ExS,/ned30m"
ill outpath = "C:/Users/drarb/Desktop/Ex5/Fill"

# Process: Fill
arcpy.gp.Fill =g(elevation, fill outpathg "")

Note the F5 shortcut for running this script that is handy as you will be doing this a lot.
Click OK when prompted to save the file.

Note that now the output file "Fill" is produced in the folder you have designated and
that the script prints 'done' when it is finished. Congratulations! You have just modified
a script and been able to execute it. This is a small but important step as it establishes
your capability to change and execute ArcGIS functions from a script file. You are now
programming and limited only by your creativity in the programming lines you can
write.

The script to this point is tracel.py in
http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2014/Ex5Scripts.zip.

Now lets edit the code to add additional functionality as follows. This imports numpy,
math, json, and os libraries that we will need later as well as env and sa classes from the
arcpy library.

16


http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2014/Ex5Scripts.zip

1 arcpy import env
1 arcpy.sa import %
import numpy

import math

j=on

import os

# Check out any necessary licenses

arcpy.CheckCutExtension ("spatial™)
env.overwriteCutput=True

# Thi=s allows the code to overwrite results - handy while deweloping
# Local wariables: (CHANGE THESE TO PATHS CN YOUR COMPUTER)
elevation = "C:/Users/dtarb/Desktop/Ex5/ned30m"

fill outpath = "C:/Users/dtark/Desktop/ExS/Fill"

# Process: Fill
orint "Bun Fill!!

farcpy.gp.Fill =sa(elevation, fill outpath, "")
outFill = Fill (elevation,"")
# The Fill cla=ss function that returns an object that can be used later

outFill.zave (fill outpath)

Run this code and see what kind of output we get. If the script ran successfully, we
should have a new raster called fill that can be opened in ArcMap. Note: the original
script used the gp.Fill_sa tool whereas the documentation states that we should use the
arcpy.sa.Fill tool. If you encounter this, | suggest that you use the tools outlined in the
ArcGIS documentation.

Note that the line env.overwriteOutput = True sets the script to overwrite any output
files that already exist. This is useful when repeatedly running a script to incrementally
develop it as we are doing here. However if you leave one of the files loaded into
ArcMap while you do this you may get an error that corrupts the raster file. If this
happens you need to delete the raster file to get it working again.

Next, lets add to our script the function to calculate flow direction. To determine the
syntax for this operation we can google “ArcGIS Flow Direction”:
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//009z200000052000000
.htm

17


http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//009z00000052000000.htm
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//009z00000052000000.htm

print '"importing arcpy (this takes a while)...

m arcpy.sa import #

# Check out any necessary licenses
arcpy.CheckCutExtension ("spatial™)
env.overwriteCutput=Irue

# This allows the code to overwrite results - handy while dewveloping
¥ Local wvariables: (CHANGE THESE T{O PATHS CN YCOUR CCMPUTER)
elevation = "C:/Users/dtarb/Desktop/Ex5/ned30m"

£fill ocutpath = "C:/Users/dtarb/Desktop/Ex5/Fill"

fdr outpath = "C:/Users/dtark/Desktop/Ex3/fdr"

# Process: Fill

print '"Bun Fill!

#a:cpy.gp.Fi;;_sa(e;evatiD:, £fill outpath, "")

outFill = Fill (elewvation,"")

¥ The Fill class function that returns an object that can be used later
3 outFill.=zave (fill outpath)

# Process: FDR

print "Run FDR'
outFlowDirection=FlowDirection (outFill, "HCOERMOL™)
outFlowDirection.save (fdr outpath)

print 'done'

The script to this point is trace2.py in
http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2014/Ex5Scripts.zip.

Notice that the output from the fill operation was not Saved, but it can still be used in
the following step! This is because it is saved temporarily in memory. We can utilize
this feature to “hide” intermediary processing outputs. Lets look at the output from the
flow direction process.
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http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2014/Ex5Scripts.zip

Now that we have some of the basic raster processing done, lets create a point that can
be traced to the outlet. This will be hardcoded for now, but we can change it to a user
input later.
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print 'importing arcpy (this takes a while) ...
# Import arcpy module

import arcpy

from arcpy import env

from arcpy.=sa import #*

nuamp

math

j=on

as

# Check out any necessary licenses
arcpy.CheckOutExtension ("spatial™)
env.overwritefutput=True

# This allows the code to overwrite results - handy while developing
# Local wvariahles: ({CHARWNGE THESE TO PATHS CN YOUR CCMPUTER)
elevation = "C:/Users/dtarb/Desktop/Ex5/ned30m"

fill outpath = "C:/Users/drarb/Desktop/Ex5/Fill"
fdr outpath = "C:/Users/dtarb/Desktop/Ex5/fdr"

# create a point obiect

my x= -1216071.141

my y=307660.098
pnt=arcpy.Point (my =, my v)

# Process: Fill
print '"Eun Fill!®

#a:cpy.gp.Fi;;_saie;evatinz, fill outpath, "")

outFill = Fill (elevation,"")

# The Fill class function that returns an object that can be used later
£ outFill.=ave (fill outpath)

# Process: FDR

print 'Eun FDR®
outFlowDirection=FlowDirection (outFill, "HNORMAL™)
outFlowDirection.=save (fdr_ outpath)

print 'done'

In order to relate this point coordinate with the raster data, we need to do two things:
(1) represent the raster grids as arrays of data, and (2) convert the x,y point coordinate
into array indices. To convert the raster grids (i.e. fill and fdr) into arrays, we use the

numpy library, specifically RastertoNumPyArray.
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print 'importing arcpy (this takes a while)...'
# Import arcpy module

import arcpy

from arcpy import env

from arcpy.=sa import *

import numpy

import math

import json

1mporc o

# Check out any necessary licenses

arcpy.CheckCutExXxtension ("spatial™)

env.overwritefutput=True

# This allows the code to overwrite results - handy while developing

# Local wvariables: (CHANGE THESE TO PATHS ON YOUR COMPUTER)
glevation = "C:/Users/drtark/Desktopn/ExS/ ned30m™

fill outpath = "C:/Users/dtarb/Desktop/Ex5/Fill"

fdr outpath = "C:/Users/dtarb/Desktop/Ex5/fdr"

# create a point object

my x= -1216071.141

my y=307660.03%8
pnt=arcpy.Point (my x, my V)

# Process: Fill

print 'Run Fill!'

#a:cpy.gp.Fill_sa(elevatinn, fill outpath, "")

outFill = Fill (elevation,"")

# The Fill class function that returns an object that can be used later
# outFill.save (fill outpath)

# Process: FDR

print 'Eun FDR®
outFlowDirection=FlowDirection (outFill, "HORMZL™)
outFlowDirection.save (fdr outpath)

# convert rasters to Arravs
fdr = arcpy.RasterToNumPyArray (outFlowDirection, nodata to wvalue=0)
fill = arcpy.RasterToNumPvArray (outFill, nudata_tn_value=ﬂﬂ

Examine the value of the fdr value to see what it looks like. You can do this by typing
the object name fdr in the Python Shell after the script has been run.
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' B

File Edit Shell Debug Options Windows Help

Python 2.7.5 (default, May 15 2013, 22:43:36) [MSC +.1500 32 bit (Intel)] on win *
32

Type "copyright™, "credits" or "license ()" for more information.

FrF RESTRART
g e g
importing arcpy (this takes a while)...
Fun Fill!
Fun FDR
dan=‘_
}}}|fdr !
arrmror Or - Or Or 0]:
(o, o0, 0, ..., 0, 0, 0],
(o, o0, 0, ..., 0, 0, 0],
-
(o, o0, 0, ..., 0, 0, 0],
(o, o0, 0, ..., 0, 0, 0],
[¢, o, 90, ..., 0, 0, 0]], drype=uintci)
v |

-

Ln:17|Col: 4

It looks like there are lots of O’s, however this is just because we are seeing a small
subset of the data. In fact most of the cells near the edge of the raster will be zero. Lets
look at some values elsewhere:

»»» £dr[100:110,100:110]

arrav([[l6, 4, 4, 4, 4, 4, &8, 4, 4, B8],
[ 4, . . , 4, 8, 8, 4, 4, 1s§],

. . . , 4, 8, 4, 8, &, 1€],

r r r r 4!’ Bl’ Bi’ Bi’ lEi’ 32]!’

. . . , 8, 1a, 8, 18, 16, 18],

16, 16, 32, 32, 1&],
16, 16, 16, 32, 1&, 32],
16, 16, 32, 1&, 32, 321,
16, 32, 32, 14, 32, 16],
16, 32, 16, 32, 32, 16]], dtype=uint8)

.
-
~
-

...
-
~
-

-
-
-

I—‘MMI-h-l—‘MMM

*PMMPI—‘MMI&

CﬂlhphlhI\JMNphlh

mmmm?mmmm
E‘U

-

.
e

-
-
-

Before we do anymore processing of the raster data, we need to extract some metadata
that will enable us to loop over the raster cells. The numpy arrays only contain raster
values, so we will need to use the ArcGIS Raster type to retrieve this information.
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# convert rasters to arrays
fdr = arcpy.RasterToNumPyArray(outFlowDirection, nodata_to_value=0)
fill = arcpy.RasterToNumPyArray(outFill, nodata_to_value=0)

# create raster object to get metadata
upperLeft = outFill.extent.upperLeft
ux = upperLeft.X

uy = upperLeft.Y

cell_width = outFill.meanCellWidth
cell_height = outFill.meanCellHeight

We can transform our point coordinates into array indices, now that we have the upper
left (x,y), cell width, and cell height. This will enable us to access the raster value of the
cell associated with our point.

# ...
# ...

# converit rasters to arrays
fdr = arcpy.RasterToNumPyArray(outFlowDirection, nodata_to_value=0)
fill = arcpy.RasterToNumPyArray(outFill, nodata_to_value=0)

# create raster object te get metadata
upperLeft = outFill.extent.upperLeft
ux = upperlLeft.X

uy = upperlLeft.¥

cell width = outFill.meanCellWidth
cell_height = outFill .meanCellHeight

# convert point coordinates into raster indices
abs(int ((ux - pnt.X) / cell_width))
abs(int((uy - pnt.Y) / cell_height))

H 0
nmn

print ‘done’
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Lets see where our point lives in the raster array (again, this is easy to do using the IDLE
Python Shell). Your coordinates may be different than those below due to the extent of

your watershed raster.

> (pnt.X,pntc.¥), '——>"',(c, )
(-1216071.141, 307660.098) —-->» (60, 209)

Now we are ready to start moving our point around within the raster. Specifically, we
want to move our point from its current location (62,210) to the next downstream cell.
In order to accomplish this, we need to add a function at the top of our script to check
the value of our flow direction grid and move the point accordingly. Place this function
right below the import statements.
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def move_to_next_pixel(fdr, row, col):

# get the fdr pizel value (z,y)
value = fdr[row, coll

#
#/ 32 | 64 | 128 |
#/ 16 | x | 1 |
#l 81 4 | 2 |
#

# move the pizel

if value ==

col += 1
elif value == 2:

col += 1

row += 1
elif value == 4:

row += 1
elif value == 8:

row += 1

col -= 1
elif value == 16:

col =1
elif value == 32:

row = 1

col -= 1
elif value == 64:

row = 1
else: #value == 128:

row = 1

col += 1

return (row, col)

This function takes in three arguments: fdr (flow direction array), row (current row
index), col (current col index). The first thing that it does is extract the value of the flow
direction grid at the current (row, col) location. It then checks this value against all the
possible flow direction combinations to determine the next downstream neighbor. It
increments the current (row, col) pair and returns the result.

Lets pass in the coordinates of our point and see which direction our cell will flow.
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R T, C

(209, &0)

I

»>> move to next pixel (fdr, r, c)
{209, B1)

>33 |

We can verify this by loading the flow direction raster into ArcMap.

Use the Go To XY Tool on the Tools Menu

BEAEQ@illes -0/ x@ 7Bl M2)0 &
Drawing = K Go To XY
Flow - Analysis ~ Find Common &4 Type in an XY location to find it.
-_ o e - _ - moae [ ra 1

Set the units to Meters

GoToXY (Meters) > 4 s B
- +\ = :-lcE‘v ] = | = |
P2

{ Decimal Degrees

Zoom in and look at the value of fdr at the selected location (using the coordinates of
our point)
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@) ExS.mxd - ArcMap |
-

File Edit View Bookmarks Inset Selection Geoprocessing Customize Windows Help

De2ds B %[0 o[ b 11417 - EEER D L
REAMN@REI« - T K@ BlaMaR TR w0z
Drawing ~ R (- - A~ @) Adal 10 +vB 1T U/ A-HZF
Flow= % | Analysis~ L - | Find Common Ancestors _ | Editor~
Table Of Contents 1 x

B S layers Ji -1,216,071 p
= U5, Cities
® i
=] 1.5, Mational Transportatiol Identify o Hx

= watershed

O
= O U.S. States (Generalized)

ety o

=1- fdr

1

= ”f'
= ®E
|}
2
E . £
ms = Location: -111.622981 41.755417 Dedmal Degrees =
W16 Field Value
32 Pixel value 1
mes Rowid o
s COUNT 10187
=] ned30m
Value
High : 2455.9
Low: 160643

= USA_MHDPlusV2
Sinks | 4
NHD Waterbodies

Identified 1 feature

Note the fdr value of 1 which corresponds to a flow direction the east consistent with
the direction that the function is moving the point

Lets modify our code to repeat this process until the point moves beyond the extent of
our raster grid (e.g. through the outlet). In order do so, we need to create a loop that
will run until the value at location (r,c) is equal to NoDATA (in this case 0).

# convert point coordinates into raster indices
= agbs(int((ux - pnt.X) / cell width))
abs (int((uy - pnt.¥) / cell height}))

H 0
[

'Tracing Downstream'
fill[z, c] # get the initial
(z = 0}

# move to downstream cell
r,c = move To next pixel (fdr, r, c)

# get the Z wvalus of the current (r,c) coordinate
z = fill[r,c]
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This loop will continue to run while the value of z does not equal O (i.e. no data value).
When a value of z=0 is encountered the while statement will be false and the loop will
stop. This code will thus move the point (r,c) to its downstream neighbor, and continue
to do so until we reach the edge of the DEM. Unfortunately, we have no output to
visualize. Let's save these points in a list and then create a shapefile that we can

visualize in ArcMap.
# ...

# converi rasters to arrays
fdr = arcpy.RasterToNumPyArray(outFlowDirection, nodata_to_value=0)
fill = arcpy.RasterToNumPyArray(outFill, nodata_to_value=0)

# create raster object to get metadata
upperLeft = outFill.extent.upperlLeft
ux = upperLeft.X

uy = upperlLeft.Y

cell_width = outFill.meanCellWidth
cell_height = outFill meanCellHeight

# convert point coordinates into raster indices
¢ = abs(int((ux - pnt.X) / cell_width))
abs(int((uy - pnt.Y) / cell_height))

print ‘Tracing Downstream!’

potX = pnt.X # get the initial X
potY = pnt.Y # get the initial ¥
z = fill[r,c] # get the initial Z
coords = [(pntX,pntY,z}] # create a list to store our coordinates

while (z != 0):

# move to doumsiream cell

last_r = r # store current v value
last_c = ¢ # store current c value
r,c = move_to_next_pixel(fdr, r, c)

# recacluate the coordinates of © and y (in map units)
potX += (¢ - last_c)+*cell_width
pntY¥ += (last_r - r)+cell_height

# get the Z value of the current (r,c) coordinate
z = £ill[r,c]

# save this coordinate to our list
coords . append ((pntX,pntY,z))

# write the output to text file (csv)
with open(’coords.txt’,’w’) as f:
for ¢ in coords:

f.write(’%5.5f, 5.5f, %5.6f\n* % (c[0],c[1],cl2]1))

print ’done’
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The script to this point is trace3.py in

http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2014/Ex5Scripts.zip.

To visualize our output in ArcMap, add the coords.txt file to an ArcMap document.

Right click on it and select Display X,Y data. Choose Fieldl as the X field and Field 2 as
the Y field. You can also symbolize these points by their elevation, Field 3

Display XY Data

A table containing X and ' coordinate data can be added to the
map as a layer

Choose a table from the map or browse for another table:

| coords.tet J

Specify the fields for the X, ¥ and Z coordinates:

X Field: Field1 -
Y Fed -
Z Field: <MNone = -

Add Data

Look in: [ﬁ scripting v] 't {E L;” %

MName: coords. bt

Show of type: | patasets, Layers and Results V]

Coordinate System of Input Coordinates
Description:

Projected Coordinate System: -
Name: MAD_1983_albers

Geographic Coordinate System:
MName: GCS_Morth_American_1983

4 3

Warn me if the resulting layer will have restricted functionality

[C] show Details

X5

About adding XY data

OK ] [ Cancel

]
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http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2014/Ex5Scripts.zip

Genee””
1.216,071.441, 307 660.099

Since point text file is not an ideal output, lets format it as a PolyLine Shapefile,
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000002p00000
0. In the code snippet below, we first create the polyline feature class that will hold our
results. Next we loop over our coordinates are create line segments between each pair.
These line segments are then added to the feature class as a polyline. Add the
following code to replace the 3 lines that create coords.txt.
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http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000002p000000
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000002p000000

# ...
# Create a Polyline Shapefile #

# create the outpui feature class
arcpy.CreateFeatureclass_management(’.’, ’path.shp’, "POLYLINE")

# define the point and line segment objects
point = arcpy.Point ()
line_seg = arcpy.Array()

featurelist = []
cursor = arcpy.InsertCursor(’path.shp?’)
feat = cursor.newRow()

for i in range(1l, len{coords)-1}):
# Set X and ¥ for start and end points
point.X = coords[i-1] [0]
point.Y = coords[i-1] [1]
line_seg.add(peint)
point.X = coords[i] [0]
point.¥ = coords[i] [1]
line_seg.add(peint)

# Create a Polyline object based on the array of points
polyline = arcpy.Polyline(line_seg)

# Clear the array for future use
line_seg.removeAll()

# Append to the list of FPolyline objects
featurelList.append(polyline)

# Insert the feature
feat .shape = polyline
cursor . insertRow(feat)
del feat
del cursor

print ‘done’

This produces an output Shapefile called path.shp. We can view this in ArcMap:
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-1.216,071.141, 307 660.098

The script to this point is trace4.py in
http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2014/Ex5Scripts.zip.

Wow! Now we have a function that can trace a path from an arbitrary point to the edge
of the DEM. Pretty impressive. This is the functionality we set out to achieve. However
it is not very easy to use. The next section will build an interface.

Part3: Developing toolbox interface

First create a symbolic layer, which will be used in the next step, to assign a theme to
one of our inputs. This will also allow us to incorporate an interactive point input
selection feature. To do this, right click inside ArcCatalog and select New -> Shapefile.
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http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2014/Ex5Scripts.zip

Set a name for this file (e.g. my_point.shp) and set the feature type to Point. Change
the symbology of this point however you would like. Lastly, right click on the

my_point.shp in the Table of Contents and select Save as Layer File.

Create New Shapefile =
Name: my_paint
Feature Type: Poirt

Spatial Reference
Description:

Unknown Coordinate System

4

[7] Show Details
[7] Coordinates will contain M values. Used to store route data.
[ Coordinates will cortain Z values. Used to store 30 data.

ok || cance |

Save Layer

[
Look in: [E| data

el B E-2E0S

£ extract_by_mask_elevation
[ extract_elevation

s 4 symbaology.lyr

Name: symbalogy.lyr

Save

v] [ Cancel ]

Save a8 type: [Layer files {=.lyr)
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Now let's add our new script to the ArcGIS toolbox, so that we can run it like any other
tool. Right click on your toolbox (e.g. Exercise5) and select Add -> Script.

G- JExercise

o Mod (5 Copy

£ Geocodi [} Paste

@D Geostati %  Remove

€3 LinearR Rename

£ Multidin

&3 Network Refresh A

&3 Parcel F Edit y

@ Schema Chec

Q Server T

o @ Spatiald___ NeW ) S| -
& Df:'-m Save As [N, To Add Script
& Dista o
& Extra Item Description... I Adds a new script tool
m Bx Gend AF  Dronerties..

Give it a name and a label. Note that | also checked Store relative path names so that if |
put the toolbox and script in a different location they will work together. Then select
next. Specify the location of the python file and select next.

- = N - B
rasoe % T " * ] (s S LD~ e

MName: Script File:

TraceDownStream

C:\Users\dtarb\Desktop\ExS\trace.py @
Label:
Show command window when executing script
TraceDownStream
Run Python script in process
Description:
Stylesheet:
[V]5tore relative path names (instead of sbsolute paths);
Always run in foreground
< Back Mext = I [ Cancel < Back ][ MNext = ] [ Cancel
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At the next dialog add input parameters. The first input parameter will be the start
point of the trace operation. Specify a Display Name (such as StartPoint) and set the
datatype to FeatureSet. Next select the Schema property and set its value to the
symbology layer that we created in the previous step. (e.g. symbology.lyr)

i~ T ==

Display Name Data Type

i fStartPoint Feature Set

) Bl

Click any parameter abave to see its properties below.

Parameter Properties

Froperty Value
Type Reguired
Direction Input
Multivalue No

C:\Users'dtarb'\Desktop\ExS\eym. .

Environment
Filter None

htinad fram ai MName: symbology.lyr

Show of type:

To add a new parameter, type the name into an empty row in the
name column, dick in the Data Type column to choose a data type,
then edit the Parameter Properties.

<pack || Emsh | [ cancel

Next add the parameter for Elevation (input).
CITNRRS. )

Display Mame Data Type
StartPoint

eature Se
Raster Dataset

Click any parameter above to see its properties below.,

Parameter Properties

Property Valug
Type Reauired
Direction | Input
MultiValue No
Default

Environment

Filter MNone
Ahtzinad fam

To add a new parameter, type the name into an empty row in the
name column, dick in the Data Type column to choose a data type,
then edit the Parameter Properties.

<Back || Enmsh | [ cancel
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Next add the parameter for Fill (output) and Flow Direction (output).

- )
Add Script

Display Name Data Type
StartPoint Feature Set
Elevation Raster Dataset

Click any parameter above to see its properties below.

Parameter Properties

Property Value

Type

Multivalue No
Default

Environment

Filter None

Miktzinad from

To add a new parameter, type the name into an empty row in the
name column, dick in the Data Type column to choose & data type,
then edit the Parameter Properties.

Display Name Data Type
StartPoint Feature Set
Elevation Raster Dataset
Fill Raster Dataset

& Flow Direction Raster Dataset

Click any parameter above to see its properties below.

Parameter Properties

Property Value o
Type Required

birection __ouput | _JI
Multivalue No

Default

Environment

Filter MNone

Pihtzinad from

To add a new parameter, type the name into an empty row in the
name column, dick in the Data Type column to choose a data type,
then edit the Parameter Properties.

RS ey S T " "

[ <gak | Ensh | [ concel

]

Lastly add Path as a shapefile (output). When all five parameters are correctly set click

Finish.

Display Mame
StartPoint Feature Set

Elevation Raster Dataset
Fill Raster Dataset
Flow Direction Raster Dataset

Data Type

Click any parameter above to see its properties below.

Parameter Properties

Property Value

Multivalue
Default
Environment

Filter Mone
Nhtzinad fram

To add a new parameter, type the name into an empty row in the
name column, dick in the Data Type column to choose a data type,
then edit the Parameter Properties.

<gack | Einish

| [ cancel
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If you do not get these settings right the first time you can get back to these controls by
right clicking on the script in the toolbox and selecting properties then the parameters
tab.

-
TraceDownStrea p - a8 g

General | Source PE"EITIEfEFSI Walidation | Help
Display Mame Data Type
StartPoint Feature Set
Elevation Raster Dataset
Fil Raster Dataset
Flow Direction Raster Dataset
Path Shapefile

Click any parameter above to see its properties below.

Parameter Properties

Property Value

| »

Type
Direction
Multivalue
Default
Environment

Filter
Ahtzimad fram

m

To add a new parameter, type the name into an empty row in the
name column, dick in the Data Type column to choose a data type,
then edit the Parameter Properties.

[ OK J[ Cancel ] Apphy

Now we need to add some code to our python script to utilize these parameters. We
use the arcpy.GetParameter(index) function to grab user inputs from the ArcGIS UL.
The following snippet gets the first parameter (i.e. Start Point) as a feature set, and
extracts the (x,y) coordinates. This code should be placed directly under the
move_to_next_pixel(fdr, row, col) function.
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fs = arcpy.GetParameter(0)
if fs == '#’ or not fs:
fs = "in_memory\\{B87AFT99A-1608-483B-9022-3AA5BEFEF3239}" # provide a default value if unspecified

# create feature set
f = arcpy.FeatureSet(fs)

# parse out the geometry

geom = json.loads(f.JSON)[’features’] [0] [’geometry’]

pnt = arcpy.Point(geom[’x’'], geom[’y’]1)

arcpy.AddMessage(’Selected Point = (i5.31,%5.31)°% (geom[’x’], geom[’y’1))

Next, let's add some code to get the rest of our inputs and outputs:

# get elevation input
elevation = arcpy.GetParameterAsText(1)

# get output fill path
fill_outpath = arcpy.GetParameterAsText(2)

# get output fdr path
fdr_outpath = arcpy.GetParameterAsText(3)

# gel output irace path
trace_outpath = arcpy.GetParameterAsText (4)

Since we are getting these parameters from ArcGlIS, we need to remove our old
hardcoded paths. We should also add some messages, since our print statements will
not appear anywhere. The final script should look like this:

38



print ’importing arcpy (this takes a while)...’
import arcpy

from arcpy import enw

from arcpy.sa import *

import numpy

import math

import json

import os

def move_to_next_pixel(fdr, row, col):

# get the fdr pizel value (z,vy)
value = fdr[row, coll

#
#/ 321 64 | 128
#1 16 | X 1
# 81 4 2

#

/ /
/ !
/ /

# move the pizel
if value ==
col +=
elif walue
col +=
row +=
elif value
row +=
elif value
row +=
col -=
elif value
col -=
elif value
row -=
col -=
elif value
row -=
else: #value == 128:
row == 1
col += 1

(]
=]

i
r

n
w

16:

32:

64 :

(ol I e e B | R | B e | I

return (row, col)

# Get Seript arguments
bt s S Sy s E e et S s S e S S S S
fs = arcpy.GetParameter(0)
if fs == *#* or not fs:
fs = "in_memory\\{8TAFT99A-1608-483B-9022-3AA58EFEF329}" # provide a default value if unspecified

# create feature set
f = arcpy.FeatureSet(fs)

# parse out the geometry

geom = json.loads(f.JSON) ['features’][0] ['geometry’]

pot = arcpy.Point(geom[’x’], geom[’y’])

arcpy.AddMessage(’Selected Point = (}5.3f,%5.3£)’% (geom['x’], geom[’'y’1))

# get elevation input
elevation = arcpy.GetParameterAsText (1)
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# get output fill path
fill_outpath = arcpy.GetParameterAsText(2)

# get output fdr paih
fdr_outpath = arcpy.GetParameterAsText (3)

# get output trace path
trace_outpath = arcpy.GetParameterAsText (4)

YRTRTETET YRTRTETRTNTRTITRT YETRTRTRTRTR I N YWTRTRTRTN IR
Lacaodod b ol o g g oo d b g o g g g g b S g

# Check out any necessary licenses
arcpy.CheckOutExtension("spatial")
env.overwriteOutput = True

# Process: Fill

arcpy.AddMessage ('Running DEM Fill...?)
#arepy.gp.Fill_sa(ned30m, Fill_ned30mi,"")
outFill = Fill(elevation, "")
outFill.save(fill_pcutpath)

# Process: FDR

arcpy . AddMessage ('Running FDR...*)

outFlowDirection = FlowDirection{outFill, "NDRMAL")
outFlowDirection.save(fdr_outpath)

# convert rasters to arrays
fdr = arcpy.RasterToNumPyArray(outFlowDirection, nodata_to_value=0)
fill = arcpy.RasterToNumPyArray(outFill, nodata_to_value=0)

# create raster object to get metadata
upperLeft = outFill.extent.upperLeft
ux = upperlLeft.X

uy = upperlLeft.Y

cell _width = outFill.meanCellWidth
cell_height = outFill.meanCellHeight

# convert point coordinates inio raster indices
¢ = abs{int((ux - pnt.X) / cell_width))
r = abs(int((uy - pnt.Y) / cell_height))

arcpy.AddMessage (' Tracing Downstream...')

pntX = pnt.X # get the initial X
pntY = pnt.Y # get the initial ¥
z = fill[r,c] # get the initial Z
coords = [(pntX,pntY,z)] # create a list to store our coordinates

while (z != 0):

# move to doumstream cell

last_r = r # store current r wvalue
last_c c # store current ¢ value
r,c = move_to_next_pixel(fdr, r, c)

# recacluate the coordinates of © and y (in map units)
potX += (¢ - last_c)*cell_width
potY += (last_r - r)+*cell_height

# get the Z walue of the current (r,c) coordinate
z = £ill[r,c]

# save this coordinate to our list
coords.append ((pntX,pntY,z))



arcpy.AddMessage(’Creating Output Path Shapefile...’)

# create the output feature class

directory_path = os.path.dirname(trace_ocutpath) # get the dir from irace_output
file_path = os.path.basename(trace_outpath) # get file name from trace_output
# create feature class

arcpy.CreateFeatureclass_management(directory_path,file_path, "POLYLINE")

# define the point and line segmenti objects
point = arcpy.Point()
line_seg = arcpy.Array()

featureList = []
cursor = arcpy.InsertCursor(trace_outpath)
feat = cursor.newRow()

for i in range(1l, len(coords)-1):
# Set X and Y for start and end points
point.X = coords[i-1][0]
point.Y = coords[i-1][1]
line_seg.add(point)
point.X = coords[i] [0]
point.Y = coords[i] [1]
line_seg.add(point)

# Create a Polyline object based on the array of points
polyline = arcpy.Polyline(line_seg)

# Clear the array for future use
line_seg.removeAll()

# Append to the list of Polyline objects
featurelList.append(polyline)

# Insert the feature
feat.shape = polyline
cursor. insertRow(feat)
del feat
del cursor

With these changes to our python script, we should be able to successfully run our tool
from the ArcGIS toolbox.
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& TraceDownStream =)
Start Point
ITraceDownStream::Start_Point =] @
@ stzrt_Point
Elevation

Z:\windows_shared\exercise 10_23_14\example_data\data\ned30m
Filled Elevation
Z:\windows_shared\exerdse 10_28_14\example_data\data\fil

Flow Direction
Z:\windows_shared\exercise 10_28_14\example_data\data\fdr
Path
Z:\windows_shared\exerdse 10_28_14\example_data\data\my_trace.shp

0 B © B

-

[ ok ][ cenel | |[environments.. || showhelp>> |

Notice that our output messages appear in the standard ArcGIS output dialog.



TraceDownStream =

Completed Close

[T Close this dialog when completed successfully

Executing: TraceDownStream "Feature Set” "Z:\windows_shered\exercise 10_23_1‘}\axar.ple_data -
\data\ned3Om" "Z:\windows_shared\exercise 10_28 l4\example data\data\fill" "Z:
\windows_shared\exercise 10_28_l4%\example data\data\fdr" "Z:\windows_shared\exercise 10_28
_l4\example data‘\data\my trace.shp"

Start Time: Mon Oct 27 19:41:53 201%

Running script TraceDownStream...

Selected Point = (-1216808.028,313803.953)

Running DEM Fill...

Running FDR...

Completed script TraceDownStream...

Succeeded at Mon Oct 27 19:41:592 2014 (Elapsed Time: 5.76 seconds)

Our end result is a PolyLine shapefile that shows that path water would flow (using D8
flow direction) to the watershed outlet.

The complete script is trace.py in
http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2014/Ex5Scripts.zip and the script
tool interface is in Exercise5.tbx in this zip file. If you have trouble developing your own
script you may use these in answering the questions below though you will need to
introduce small modifications to answer some of the questions. You will need to add
Exercise5.tbx to your map document and keep trace.py in the same folder. | have found
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that unless after doing this | save the document then close and reopen ArcMap, | get an

error.
Homework Questions

1. Prepare a layout showing the elevation grid and two trace downstream paths.
Include a scale and label the length of each trace in the layout.

2. Write statements to determine and print the value of the flow direction array at
location with map coordinates (-1214936, 309638). You will need to determine
the array coordinates corresponding to this and then look up and print the value
of the fdr array at this location. Give the code you changed to achieve this and
show a screen shot of your output, either from print statements to the shell or
arcpy.Addmessage statements to the ArcGIS output.

3. Modify the script to compute and print out the length of the flow path being
traced. Give the code you changed to achieve this and show a screen shot of

your output.

4. Explain (without doing) how could you modify this code to determine the longest
flow path in the entire watershed?
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